
Finisher for FCP
Please use Provide Feedback… under the application menu for bug reports, feature requests 
or support.

Quickstart Guide
1. Log in Final Cut Pro following the guidelines in Logging in Final Cut Pro. Depending 

on the type of Sequence you are attempting to finish, you can enter more, or less 
metadata. Finisher will use all the metadata/log notes entered for First Cuts and 
will require that if you are finishing a Sequence from a long form Documentary. 
However, Finisher does not always require the full ranking, story keywords, 
speaker on camera, location, Event or Theme and (if the clip is A-roll) some B-roll 
search terms if the project is simple. See more information in Logging Basics for 
Finisher.

2. Export the logged bins from Final Cut Pro as an XML file.
3. Run either First Cuts for FCP or Finisher for FCP and import the XML file.

• 
 If using First Cuts for FCP select the Finisher icon in the Tool Bar. Use the Tool 
Bar control button at top right of the interface to display or hide the Tool Bar.

4. Optional: Choose a Motion Template for Lower Third style.
5. Click the Make the Edit button and save the result as Final Cut Pro XML.
6. Import the XML of the Sequence back to Final Cut Pro and review the Sequence.

Contents
• Logging in Final Cut Pro - setting up

• Logging in Final Cut Pro - logging basics

• Logging in Final Cut Pro - Trimming and Subclipping

• Using Finisher - making edits overview

• Using Finisher - Importing Bins

• Using Finisher - making edits

• Back to Final Cut Pro

• Activating Finisher for FCP

• Moving Finisher for FCP to another computer

http://theassistanteditor.com/Finisher/help/logging1.html
http://theassistanteditor.com/Finisher/help/logging1.html
http://theassistanteditor.com/Finisher/help/logging2.html
http://theassistanteditor.com/Finisher/help/logging2.html
http://theassistanteditor.com/Finisher/help/logging2.html
http://theassistanteditor.com/Finisher/help/logging2.html


Logging in Final Cut Pro - setting up
The column names and preset
Finisher for FCP uses the following Logging Columns in Final Cut Pro:

• 
 Label: Set from 1 to 5 and used for ranking the quality of Clip content/visual quality. 
1 is the highest quality and most valuable material; 5 is the least valuable material.

• 
 Good: When the Good checkbox is on First Cuts for FCP knows that this clip can be 
used to start a story or sequence. In our language we call this a “strong start” Clip.

• 
 Master Comment 1: “Story Keywords” - This is where you enter keywords, or tags, 
for this clip. 

• 
 Master Comment 2: “Location” – Where was this shot taken.

• 
 Master Comment 3: “Speaker” – Whoʼs on camera.

• 
 Master Comment 4: “Event or Theme” – in the whole arc of the documentary what 
main story or theme does this fit into. 

• 
 Comment A: “B-roll Search Keywords” – What keywords to search for to match B-
roll to this A-roll clip. 

Setting Column names and Labels
You can set these labels, after displaying the column, by Control-clicking (or Right mouse 
clicking) on the column heading in List View and selecting Edit Heading. Then type in the new 
name.

Alternatively, you can choose the Edit menu and 
select 
Project 
Properties to  enter the Master Comments in one 
place.



The Labels can be set by choosing the Final Cut Pro menu and selecting User Preferences. 
Choose the Labels tab and enter 1 through 5 as the labels.

Column Layout
We have provided a template for Column Layout that displays the Columns required by First 
Cuts for FCP and Finisher for FCP. It is called “TAE Layout” and is available for download.
Unfortunately we cannot provide a preset that names the Master Clip 1-4 and Comment A 
columns. This only needs to be done once per project. All new Bins created after that will have 
the correct column names, which are stored with the project.
We have also provided a Project Template with the columns named and displayed and Labels 
set as 1 to 5 (download).
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Logging in Final Cut Pro - logging basics
Types of Clips
Within the logging of documentary footage, Finisher for FCP works with these types of Clips:

• 
 An edited Sequence with Video Clips in Video 1 and matching audio clips.

• 
 B-roll.

• 
 Lower Third Titles
NOTE: If these items have been entered in a project for First Cuts for FCP the same 

metadata/log notes will be used in Finisher for FCP. There is no need to re-enter any 
log notes.

B-roll
B-roll clips are related to the action or dialog but not part of it. They are used by Finisher for 
FCP to remove jump-cuts and to add visual interest. B-roll Story Keywords, and the Story 
Keywords for searching for B-roll (held in the "B-roll Search Keywords" field or Comment A) are 
optional. Leaving both blank will still get a potentially useful result from Finisher for FCP but the 
B-roll will be assigned randomly if no log notes are entered; or by location if location is entered.
Best results will be had by entering B-roll story keywords in Master Clip 1 for B-roll clips, adding 
location (if more than one) and adding B-Roll Search terms for the A-roll clips, or enter B-roll 
Search terms in the comment field of a Sequence Marker (with duration).

Lower Third Titles
Any Motion Master Template (whether supplied by Apple or created by yourself) can be used as 
a Template for the Lower Thirds Titles added by Finisher for FCP where appropriate.
A Lower Third Title has the words “Lower Third” in the name of the Template. (Motion Master 
Templates supplied by Apple have this naming convention.)
A Lower Third Title will be generated if the A-roll clips have the name of the person on camera 
entered in the Name (Master Clip 3) field in Final Cut Pro. If there is no name in the Name field 
(or Master Clip 3), no Lower Third will be generated.

Note: Multiple Templates for Lower Third Titles can be sent to Finisher for FCP by 
including them in the Bins before sending to Finisher for FCP. You can choose which 
one to use for any individual edit from within Finisher for FCP interface.

Sequence Markers
Finisher for FCP includes the ability to use Sequence Markers that have a duration entered, as 
a guide to the placement of B-roll. Place a Sequence Marker at the start of where B-roll is 
required (M on the keyboard) and move forward to where you want the B-roll to finish and 
Extend the Marker to that location (Option + ` on the keyboard).



Optional (but recommended): Sequence Markers can have B-roll search terms entered in the 
Comments field (Marker name is ignored) and Finisher for FCP  will search for matching B-roll 
for that Marker.

Log Notes: Field by Field Description
In this section I describe in a little more detail the types of metadata/log notes that go in each 
field for Finisher for FCP. We have provided a PDF "cheat sheet" that summarizes the log notes 
that are needed, optional or left blank for each type of clip - a handy guide while you are logging 
clips.

Story Keywords  (Master Clip 1)
This is where you enter keywords, or tags, for this clip. You can enter multiple keywords 
separating with a comma. When multiple words are entered, each item between commas is 
identified as a keyword. So a keyword sequence could look like: Austria, Austrian, going for 
breakfast, bread. In this example “going for breakfast” is one story keyword. 
Include as many story keywords as there are stories that this clip will be relevant for. Avoid 
entering too many story keywords as that will make the clip come up in more edits.
There is no limit to the number of Story Keywords you can assign to a clip, and no limit on the 
combination. Unfortunately, while you can Control-click (or Right mouse click) on the field, the 
each combination of story keywords is presented as a different item, so the contextual menu 
becomes too long and unwieldy to be useful. This means that we have to be careful to be 
consistent with story keywords.

Location (Master Clip 2)
An identifier for where this clip was shot. Use the contextual menu to ensure consistency 
between data entry sessions. When right-clicking, or control-clicking, on a field in Final Cut Pro, 
a list of existing entries for that field will be displayed making consistent entry easy. Only one 
location per clip is supported.

Speaker – whoʼs on camera (Master Clip 3)
Enter the name of the A-roll Clip's speaker on camera. Again, use the contextual menu to 
ensure consistency between data entry sessions.
If the shot starts on one speaker and ends on another, enter both names with a comma in 
between. If there is more than speaker in the shot, enter as if one name. For example:

“Dell Draxl”  when just Dell is in the shot;
“Dell Draxl, Ziggy Draxl” for when the shot starts on Dell and pans to Ziggy;
“Dell and Ziggy Draxl” for when both are in the shot together;
“Dell and Ziggy Draxl, Ziggy  Draxl” would indicate a shot that started on both and ended 
only on Ziggy Draxl.

http://theassistanteditor.com/FirstCuts/help/Logging%20cheat%20sheet.pdf
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IMPORTANT: Leave the Speaker field empty if the Clip is to be used for B-roll. Clips 
without Speakers are B-roll by definition.

B-roll Search Terms (Comment A)
If this is an A-roll clip, enter keywords that would help find relevant B-roll for this clip. For A+ 
clips that donʼt need B-roll, enter a plus sign (+). Naturally, leave this field empty for B-roll clips.

Creating Motion Master Templates
Finisher for FCP works with Motion Master Templates for 
Lower Thirds or for Opening titles. It will not work with 
any Motion Project, only those saved as a Template. (In 
Motion these are Motion Templates; in Final Cut Pro they 
show as Master Templates.) Itʼs trivial to convert from a 
Motion project — derived from an existing template or 
completely original work — to a Motion Master Template 
that Finisher for FCP will use.
Create the Motion project as you want it to look. Before 
you save out the template, you need to make a change 
to any video layers that you want to be able to change in 
Final Cut Pro. Select the layer you want to convert to a 
drop zone, navigate to the Inspector and the Image Tab 
and click the Drop Zone checkbox ʻonʼ. Text fields are 
always editable in Final Cut Pro — at least size and content is: position, font and color are set in 
the template.
To save as a Template, choose the File menu and select Save as Template. The Save Template 
dialog opens. Format should be obvious: for an HD project, choose HD; for NTSC or PAL, choose 
them from the pop-up menu.
At first it will seem like you canʼt save the Template anywhere — all the Themes are locked. 
Click the New Theme button and create your own theme. A good approach would be to create a 
Theme for a project.
For a Master Template you have the choice of including a QuickTime Preview, so you can see 
what the effect is visually in the Final Cut Pro Master Template browser.
Whether you choose to Collect Media or not depends on whether or not you need to keep 
media with the template.
Once saved as a Motion Template, itʼs available in Final Cut Pro as a Master Template, ready to 
be used in every project you make.
Open a Master Template in the Viewer by using the Viewer window's Generator menu, or by 
using the Motion Template palette from the Sequence menu. 
Drag the Master Template from the Viewer to the Bin/Browser to add it to your project.



Trimming and Subclipping
Finisher for FCP, like most editors, works with selects (trimmed clips). It will work with any 
combination of trimmed clip, Subclip, or trimmed subclip. Personally I prefer to subclip the A-roll 
selects quite “loosely” (without cutting too tight) with the expectation that final trimming will 
happen later. 
With B-roll I trim to much longer than I ever expect to use and generate a subclip from that and 
then trim to a visually interesting duration. Most B-roll has only a certain duration that it will be 
interesting and that should guide how itʼs trimmed, within the subclip.

NOTE: Any filters, including Color Correction, Motion Settings or Speed Adjustments 
added to Clips in the Bins at the logging stage will be retained and used by Finisher 
for FCP.

Bin Structures
Finisher for FCP will ignore the bin structures you use for your organizational purposes, as well 
as any log notes entered into any field other than those specifically mentioned above. You are 
free to use whatever bin structure you like, included bins within bins within bins.
Finisher for FCP will find relevant clips based on story keywords, regardless of which bin they 
are in.

Exporting XML
Select the edited Sequence and the Bin(s) containing logged clips relevant to that Sequence. 
Select the Sequence and then Command + click on the relevant Bins of B-roll and Motion 
Template Clips. (Bins may contain A-roll which will be ignored by Finisher for FCP.) Clips can be 
included by Command + clicking on them.
From the File menu choose the Export submenu and select XML. If you are exporting Motion 
Templates you must use XML version 4. Version 4 XML is the recommended version.

Note: If you export to XML version 3, the Lower Third titles that Finishers for FCP returns 
will be based on the Outline Text Title Generator. There is a default version included 
with Finisher for FCP but you can optionally include an Outline Text Title clip with the 
font, size and color choices for your Sequence and that will be used instead.

There's more information about exporting XML at Apple's website.

http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/Documents/chapter_2_section_2.html
http://developer.apple.com/documentation/AppleApplications/Reference/FinalCutPro_XML/Documents/chapter_2_section_2.html


Using Finisher for Final Cut Pro - 

 making edits overview
The basic workflow for making edits within Finisher for FCP is:

• 
 Import the XML file with the Bin information.

• 
 (Optional) Choose your Lower Third Style (the default is Outline Text Lower Thirds).

• 
 Click the Make the Edit button to generate a Fast First Cut.

• 
 Enter a file name and save the file.

• 
 Import the Sequence XML back to Final Cut Pro and review.

Using Finisher for FCP - importing bins
Click the Browse button (or choose the File menu and select Open) to show an Open dialog. 
Select the XML file exported from Final Cut Pro containing the logged Bins. There is the option 
to cancel at this point, but Finisher for FCP canʼt get started until it opens and parses an XML 
file with Clip information in it. A Sequence must be included in the exported XML, otherwise an 
error message will be generated.

Importing Bin Data
Once a suitable XML file is selected, Finisher for FCP will take a short time to open the file, and 
then will progress through all the clips in the XML file, preparing to Finish the cut for you.
The process of opening and parsing the XML file will vary according to the number of Clips and 
the speed of your computer. For reference: on a CoreDuo (first series) MacBook Pro 310 clips 
takes approximately 2 minutes to open.
When the clips are prepared, there will be an indication in the interface about the total duration 
of B-roll available, and other useful information.



Making Edits in Finisher for FCP
There is only one option for Finisher for FCP - choose the Lower Third Style from the pop-up 
menu.

Going back to Final Cut Pro
Saving XML 
Once all your settings are complete, click the Finish the 
Edit button. The edit will be completed in seconds and a 
Save dialog will open.
Navigate to where you want the file to be saved and enter a 
useful name. By default the Sequence will be named 
according to the primary keyword selected. If additional Story  
Keywords are selected the default name will be the primary 
keyword, a comma, followed by "etc".

In Final Cut Pro
Import the XML file by choosing the File menu and from the 
Import submenu select XML. The XML import dialog will 
open.
In the Import XML Dialog:

• 
 Target the appropriate Destination - i.e. the project that you want to insert this Sequence 
into;

• 
 If you choose to create a new project, Final Cut Pro will require you to 
name and save it before beginning the import.

• 
 Confirm that the Reconnect to Media Files checkbox is 'on' otherwise the media will 
not be reconnected automatically.

• When ready, click OK to import.
NOTE: We do not expect any errors on import. Please report import errors to 

techsupport@intelligentassistance.com.
The Sequence will be ready for you to view and/or polish.

mailto:techsupport@intelligentassistance.com
mailto:techsupport@intelligentassistance.com


Activating Finisher for FCP
After you install Finisher for FCP onto a computer, it will need to be activated with a Serial 
Number before it can be used. Each serial number can be used to activate only one computer at 
a time. If you want to activate the software on another computer, youʼll need to deactivate it first. 
See Moving Finisher for FCP to another computer for details.
Youʼll temporarily need internet access for the activation so that the software can connect to our 
server and confirm the serial number.

• When the software is first run it will display a Software License Agreement. Read the 
license agreement and click the I Agree button at the bottom of the page.

• Enter the Serial Number that was given to you and click the Activate button. The 
software will send the serial number to our server for confirmation.

• Youʼll get a message in green saying that youʼve successfully activated your license. 
Click the Continue button.

If the software could not be activated with the Serial Number, youʼll get a message in red 
explaining the reason, such as:

• This is not a valid Serial Number - check to make sure you have entered the serial 
number correctly;

• This is not a Serial Number for Finisher for FCP - make sure youʼre entering a serial 
number that can be used to activate Finisher for FCP;

• The Serial Number has already been activated - if you want to activate Finisher for 
FCP on this computer you'll need to deactivate the other installation before 
activating this one, or purchase another serial number.

Moving Finisher for FCP to another computer
To move Finisher for FCP from one computer to another, you'll deactivate it on the first 
computer, then activate the installation on the second computer.
To deactivate the software on one computer and activate it on a different computer, both 
computers will temporarily need internet access.

• On the first computer, choose Deactivate from the application menu.

• Confirm that you want to deactivate the software by clicking the Deactivate button.

• Youʼll receive a message in green saying that youʼve successfully deactivated your 
license.

• On the second computer, run Finisher for FCP, and follow the instructions for 
Activating Finisher for FCP.


